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1Touchpad MODULAR Ver. 4.0-IV (Answer Key)

	   The Computer—An Overview

Exercise
A.	 1. c.	 2. b.	 3. c.	 4. a.	 5. b.
B.	 1. F	 2. F	 3. T	 4. T	 5. T
C.	 1. Printer	 2. ALU	 3. Touchscreen	 4. Monitor	 5. Plotter
D.	 1. Barcode reader, Flatbed scanner and Sheetfed Scanner
	 2. Printers, Speakers, Visual Display Unit
	 3. The images that you see on the monitor are made up of tiny dots called pixels.
E.	 1. The three main components of CPU are:
	 	 ALU (Arithmetic Logic Unit): Performs mathematical and logical operations.
	 	 CU (Control Unit): Directs all the operations of a processor.
	 	 MU (Memory Unit): Stores data and instructions.
	 2. The most commonly used printers are: Dot matrix printers, Inkjet Printers.
	 	� Dot matrix printers work like typewriters. The printer head strikes the paper and ink ribbon 

to print a character.
	 	 The Inkjet printer prints line-by-line by spraying ink on a sheet of paper.
F.	 1. Manan needs a Web Cam and it is an input device.
	 2. Touchscreen

	   Personalising Windows 10

Exercise
A.	 1. b.	 2. b.	 3. d.	 4. d.
B.	 1. F	 2. T	 3. T	 4. F
C.	 1. Start Menu	 2. Right	 3. System Clock	 4. Folder

1.

2.
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D.	 1. �A small graphical representation of various files/folders, programs or applications are known 
as icons.

	 2. ‘This PC’ window represent all the drives on your computer.
	 3. Show Desktop Button
	 4. Windows
E.	 1. �‘This PC’ icon lets you see everything that is stored in your computer. It is useful for finding, 

organising and storing files in your computer.
	 2. Components of Windows 10 desktop are Desktop Background, Icons and Taskbar.
	 3. �A file is a document that contains a collection of related information whereas, a folder is like 

a file cabinet in which you can keep your files.
F.	 1. Gaurav should use This PC icon.
	 2. Siya needs to double click to open the folder.

Worksheet 1
(Based on chapters 1 & 2)

A.	 1. Inkjet Printer	 2. Webcam	 3. Graphics Tablet		 4. Joystick
B.	 1. F	 2. F	 3. T	 4. F
C.	 1. c.	 2. a.	 3. b.

	   Introduction to Word 2019

Exercise
A.	 1.	a.	 2. b.	 3. c.	 4. a.	 5. d.
B.	 1.	F	 2. T	 3. T	 4. F	 5. T

C.	 Title BarQuick Access Toolbar

Status Bar

Rulers Scroll Bars

Zoom Slider

3.
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D.	 1.	Ribbon is made up of Tabs and Groups.
	 2.	Save icon is located on the Quick Access Toolbar.
	 3.	To select a line using mouse, Click on the left margin of the line.
E.	 1.	Word 2019 can be used to:
	 	 a. Type letters, stories, reports, etc., in a simple way. 
	 	 b. Make changes in the text while typing and after typing as well.
	 2.	Undo is used to cancel a command. Shortcut keys to Undo is Ctrl + Z.
	 	 Redo is used to reverse the action of Undo command. Shortcut keys to Redo is Ctrl + Y.
	 3.	�Copying and Pasting the text means the selected text will remain at its original location as 

well as the place where it is pasted.
	 	 The shortcut to copy is Ctrl+C and Paste is Ctrl+V.
F.	 1.	�The red lines indicates spelling mistakes. He needs to use Spelling & Grammar option. The 

steps are:
	 	 a. Right-click on the word.
	 	 b. �Choose and click the correct spelling or word from the suggestions to replace the incorrect 

word. 
	 2.	Nikita can use Thesaurus to find a synonym for a word in her document. The steps are:
	 	 a. Select the word you want to look for.
	 	 b. Click on Review tab.
	 	 c. Click on the Thesaurus option from the Proofing group.
	 	 d. Right-click on the appropriate word and click on insert.

	   Formatting in Word 2019

Exercise
A.	 1.	b.	 2. b.	 3. b.	 4. c.
B.	 1. Italic	 2. Font	 3. Border & Shading	 4. Editing
	 5. Bulle
C.	 1.	�Highlighting text means marking the important text and placing a coloured rectangle  

over it.
	 2.	�The position of the text or the way the text is set with respect to the margins in a document 

is called alignment.
	 3.	�The four change case options are: Sentence case, lowercase, UPPERCASE, Capitalize Each 

Word.

4.
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D.	 1. To apply text effects, follow the given steps:
	 	 a. Select the text.
	 	 b. Click on Home tab.
	 	 c. Click on the Text Effects button from the Font group.
	 	 d. From the effects that appear, select the effect you want to apply.
	 2. �Format Painter command is used to apply the same formatting, such as font colour, style or 

size to another text within the same document.
	 3. To apply Drop Cap effect, follow these steps:
	 	 a. Select the paragraph and click Insert tab.
	 	 b. Click on Add a Drop Cap option in the Text group.
	 	 c. Select the desired Drop Cap effect.
E.	 1. �Aayush can use Format Painter to apply the same formatting, such as font colour, style or 

size to another text within the same document.
	 2. �Mehak can apply artistic border by clicking on drop-down arrow in the Art option of Page 

Border tab in Borders and Shading dialog box.

Worksheet 2
(Based on chapters 3 & 4)

A.	 1. b.	 2. e.	 3. a.	 4. c.	 5. d.

B.	

Tabs

Rulers

Text/Document Area

Scroll Bars

C.	 1. Font	 2. Text Effects	 3. Bullet	 4. 11

Test Sheet 1
(Based on chapters 1 to 4)

Section A

A.	 1. c.	 2. a.	 3. a.	 4. c.	 5. b.

	 6. c.	 7. b.	 8. c.
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B.	 1. Laser	 2. Scanner	 3. Shortcuts	 4. Thesaurus	 5. Status bar

C.	 1. F	 2. T	 3. T	 4. T	 5. T

	 6. T
Section B

A.	 1. The parts of a computer that we can see and touch are called Hardware.
	 2. Shortcut menu saves your time to access the commands.
	 3. Quick Access Toolbar, Title Bar and Text/Document Area.

B.	 1. �A computer accepts data and instructions from you through input devices. Data can be in 
the form of numbers, text, sound or graphics. Examples: Keyboard and Mouse.

	 2. To insert bullets in your document, follow the steps:
		  Step 1: Click on Home tab.
		  Step 2: Click on the drop-down arrow next to the Bullets/Numbering in the Paragraph group.
		  Step 3: Select the type of bullet you want to use.

	 3. �A file is a document that contains a collection of related information. The file in a computer 
can be text document, spreadsheet, picture, music or even movie. It is represented by an 
icon. To create a new file in the folder, follow these steps:

		  Step 1: Click on drive, open the folder in which you want to create a new file.
		  Step 2: �Right-click in an empty section of the folder. Click on New option from the pop-up 

menu.
		  Step 3: �Click on the desired file option from the sub-menu. A new file will be created in your 

folder.
	 4. �In Word 2019, spelling mistakes are shown by red wavy line and grammatical mistakes by 

blue wavy line. 
		  To check spelling and grammar, follow these steps:

		  Step 1: Right-click on the word.

		  Step 2: �Choose and click the correct spelling or word from the suggestions to replace the 
incorrect word.

	   Graphics and Tables in Word 2019

Exercise
A.	 1.	c.	 2. a.	 3. c.	 4. b.	 5. b.
B.	 1.	T	 2. F	 3. F	 4. T	 5. T

5.
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C.	 1.	WordArt allows you to create text effects that are not possible through text formatting
	 2.	Merging refers to combining two or more cells in the same row or column into a single cell.
	 3.	Layout Tab gives the option of Splitting cells.

D.	 1.	To add symbols to your document, follow these steps: 

		  a. Click on the Insert Tab.

		  b. Click on the Symbol command in the Symbols group.

		  c. Click on any symbol you want to insert.

	 2.	Yes, it is possible to insert text in a shape. To insert text, follow these steps::

		  a. Right-click inside the shape.

		  b. Select the Add Text option.

		  c. Type the desired text.

	 3.	Insert Tab and Tables group are used to add a table in the Word document.

E.	 1. Vishal can use WordArt to create text effects that are not possible through text formatting.
	 2. �Mannat can insert the symbol © by clicking on the Insert tab → Symbols Group → Symbol 

command.

	   Page Formatting and Mail Merge in Word 2019

Exercise
A.	 1.	b.	 2. c.	 3. a.	 4. c.	 5. b.
	 6.	b.
B.	 1.	Single	 2. Line	 3. Letter	 4. Footer	 5. Custom

C.	 1.	The shortcut to add a line break is Shift + Enter key.

	 2.	Main Document contains the text of the letter which we want to send to our friends.

	 3.	�By default, the data source file is saved in My Data Sources folder under the Documents 
folder.

D.	 1.	The steps to insert header and footer are:
	 	 a. Click on Insert tab.
	 	 b. Click on the Header/Footer command.
	 	 c. Select the header/footer from various available header/footer templates.
	 	 d. Type a suitable header/footer of your choice.
	 	 e. Click on Close Header and Footer option.

6.
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	 2.	The steps involved in Mail merge are:
	 	 a. Creating the Main Document.
	 	 b. Creating a Data Source
	 	 c. Merging the Main Document and Data Source.
	 	 d. Inserting Merge Fields
	 3.	�Indentation is the distance of the text from either the left or the right margin. To indent  

the text:
	 	 a. Select the text and click on Layout tab.
	 	 b. Click on Indent Increase or Indent Decrease button in the Paragraph group.
E.	 1.	Tanvi can use Mail Merge.
	 2.	He should use Landscape orientation.

Worksheet 3
(Based on chapters 5 & 6)

A.	 1. e.	 2. d.	 3. a.	 4. b.	 5. c.

B.	

7

M E R

EB LAT

G

G

I

UOYA T

O
C

L
R W

L
I
T
T

N

P
S

6
5

2

4

3

1

S

I

E SL

I

YT
E

Z
I

N
G

M
N

GN G

	   Introduction to Internet

Exercise
A.	 1.	b.	 2. a.	 3. b.	 4. c.
B.	 1. F	 2. T	 3. F	 4. F
C.	 a.	Microsoft Edge		  b. Google Chrome		 c. Mozilla Firefox

7.
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D.	 1.	�World Wide Web (WWW) is the largest collection of information in the form of websites on 
the Internet.

	 2.	�Web page is a part of a website. It contains text, pictures, sounds, videos, animations, etc. It 
is stored in an electronic form on a computer connected to the Internet.

	 3.	�Internet is a global network connecting millions of computers and computer networks all 
over the world. It is also called The International Network.

E.	 1.	�To connect your computer to the Internet, you need the following things:
		  a. A computer		  b. A telephone or cable line
	 	 c. A modem or a network card	 d. Software (Web browser)
		  e. A company providing Internet connection 
	 2.	Uses of Internet are:
		  a. search information on any topic
		  b. send and receive e-mail messages
		  c. chat online
		  d. play online games
	 3.	Main Parts of Microsoft Edge:
		  a. Title Bar: This shows the title of the opened web page.
		  b. �Settings and more: This shows various items for operation on web pages and Internet 

settings.
		  c. �Current Tab: Edge uses tabs for each web page you have open. The current tab you have 

open appears as a light grey, while those not open are dark grey.
		  d. Back: The back button helps you to navigate back to your previous page.
		  e. New Tab: Click this button to open a new tab.
		  f. Refresh: Refresh button reloads your page.
		  g. Address Bar: You type web addresses or carry out a web search in the address bar.
F.	 1.	�Mallika needs a telephone or cable line, a modem or a network card, Software (Web browser) 

and a company providing Internet connection.
	 2.	Rohit should type the address in the Address bar of the web browser window.

	   More Games of Google Blockly

Exercise
A.	 1. b.	 2. a.	 3. d.	 4. b.	 5. b.
B.	 1. does not have worm	 2. Circle	 3. Two	 4. One
	 5. Instructions

8.
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C.	 1. Visit the website https://www.blockly.games/ to play the Bird game.
	 2. Heading block is used to change the angle of turning of bird.
	 3. The Bird game teaches the concept of rotation by an angle to the users.
	 4. The Turtle category has two blocks:
		  a. The move…by block
		  b. The turn…by block
D.	 1. The Reset button is used to return the turtle/bird to its original position.
	 2. �The Turtle game teaches the concept of drawing by moving the turtle across the drawing 

board.
	 3. �The repeat…times do block to make the turtle repeat tasks given inside the block for given 

number of times.
	 4. The Reset button is used to return the turtle/bird to its original position.
E.	 1. Naman should use Heading block to modify the turning angle.
	 2. The repeat…times do block should be used to achieve this.

Worksheet 4
(Based on chapters 7 & 8)

A.	 1. World Wide Web (WWW)	 2. Home Page	 3. Website	 4. Internet
B.	 1. This block turns the object in the left direction from the direction it is facing.
	 2. �This block allows the bird to fly in one direction until the condition is true and change direction 

when the condition becomes false.
	 3. �The condition that allows the bird to move in the direction in do section of the block until 

the condition is true, otherwise move in the direction in the else section of the block when 
the condition becomes false.

	 4. The move…by block is used to make the turtle move forward or backward to draw the shape.
	 5. �The repeat..times do block to make the turtle repeat tasks given inside the block for given 

number of times.

Test Sheet 2
(Based on chapters 5 to 8)

Section A

A.	 1. a.	 2. c.	 3. b.	 4. a.	 5. a.
	 6. b.	 7. b.	 8. c.
B.	 1. Turn	 2. Turtle	 3. Splitting	 4. Resizing	 5. Portrait



Touchpad MODULAR Ver. 4.0-IV (Answer Key)10

	 6. Page Setup
C.	 1. F	 2. T	 3. T	 4. F	 5. F
	 6. F	 7. T	 8. T

Section B

A.	 1. �We get information from different websites. These websites open in a software known as 
web browser.

	 2. With Table Styles feature in Word 2019, you can format the entire table quickly.
	 3. �You can also insert more than three columns in the document by clicking on More Columns 

option.
	 4. �The Turtle game teaches the concept of drawing by moving the turtle across the drawing 

board to the users.
B.	 1. �Microsoft Edge is the most common web browser available almost on every computer as it 

comes with all new editions of Windows. Three main parts of Microsoft Edge are:
	 	 a. Title Bar	 b. New Tab	 c. Refresh
	 2. You type web addresses or carry out a web search in the address bar.
	 3. To merge two or more cells, follow these steps:
	 	 Step 1: Select the cells to be merged.
	 	 Step 2: Click on the Layout tab.
	 	 Step 3: Click on the Merge Cells command.
	 4. Steps to draw a square in Blockly are:
	 	 Step 1: Click on the Turtle option. A dialog appears on the screen telling the user what to do.
	 	 Step 2: Click on OK button to start the game.
	 	 Step 3: Drag the following blocks to draw a square: 

	 	

	 	 Step 4: Click on Run Program button to see if the drawing is complete or not.


